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Chapter 2, Configuring Communications 0

December 10, 2001

Creating or Modifying a Communications Configuration 0

Setting Configuration Parameters
In Table 2-1, in the description of the DialingFilter.RuleN configuration parameters, which starts on 
page 2-28, it should be noted that the numeric elements in the names of the filter rule parameters 
are applied by string comparison, from small to large. For example, this means that a dialing filter 
named DialingFilter.Rule11 will be applied before one named DialingFilter.Rule2.

You should use the same number of digits for each rule, according to your total anticipated number 
of rules. For example, the numeric elements in the filter rules could use a sequence starting with 
000, followed by 001, and so on, up to 999.

Chapter 3, Working with Communications Events and 
Commands 0

December 10, 2001

Special Commands and Special Events 0

Using Special Events
In Table 3-8, which begins on page 3-19, several special events should replace the existing special 
events that have the same names but without the “Pre” or “Post” component to the names. These 
special events correspond to client handle methods, and include work item attributes. For more 
information, see “Work Item Attributes” in Chapter 4. For more information about the client handle 
methods, see “Methods of ISC_CLIENT_HANDLE” in Appendix C. These special events should also 
be noted in Table F-10 in Appendix F.

The special events shown below have some or all of the following attributes:

■ ChannelType – The language-independent value representing the channel type of this work item.

■ ProfileName – The communications driver profile for which this work item is applicable.

■ WorkItemID – The ID number of this work item.
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■ WorkItemMode – The mode of this work item, where 1 represents an inbound work item and 2 
represents an outbound work item.

Table 1-1 lists the special events to replace the existing special events, as described earlier.

Table 1-1. Special Events (1 of 2)

Event Name Description

@PreIndicateNewWorkItemEvent

@PostIndicateNewWorkItemEvent

Respectively, these special events correspond to just before, and just 
after, the client handle method IndicateNewWorkItem is invoked. 
These special events have the following attributes:

■ ChannelType 

■ ProfileName

■ WorkItemID

■ WorkItemMode

@PreWorkItemReleasedEvent

@PostWorkItemReleasedEvent

Respectively, these special events correspond to just before, and just 
after, the client handle method WorkItemReleased is invoked. These 
special events have the following attributes:

■ ChannelType

■ ProfileName

■ WorkItemID

@PreWorkItemResumedEvent

@PostWorkItemResumedEvent

Respectively, these special events correspond to just before, and just 
after, the client handle method WorkItemResumed is invoked. These 
special events have the following attributes:

■ ChannelType

■ ProfileName

■ WorkItemID
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Event Responses 1

Event Response Process Overview
On page 3-29, the event response parameter InvokeMethodIfNoData2 is mentioned. This parameter 
is not supported in Release 7.x, and should be listed as Removed (obsolete) in Table F-7 in 
Appendix F.

Event Response Parameters
In Table 3-10, on page 3-32, the event response parameter InvokeMethodIfNoData2 is described. As 
mentioned, this parameter is not supported in Release 7.x, and should be listed as Removed 
(obsolete) in Table F-7 in Appendix F.

@PreWorkItemStartedEvent

@PostWorkItemStartedEvent

Respectively, these special events correspond to just before, and just 
after, the client handle method WorkItemStarted is invoked. These 
special events have the following attributes:

■ ChannelType

■ ProfileName

■ WorkItemID

@PreWorkItemSuspendedEvent

@PostWorkItemSuspendedEvent

Respectively, these special events correspond to just before, and just 
after, the client handle method WorkItemSuspended is invoked. 
These special events have the following attributes:

■ ChannelType

■ ProfileName

■ WorkItemID

Table 1-1. Special Events (2 of 2)

Event Name Description
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Commands 1

Command Parameters
In Table 3-15, on page 3-52, the note in the description of the HotKey parameter is incorrect. The 
note should be replaced with the following note:

NOTE: If you specify keyboard shortcuts, using the HotKey parameter, that conflict with keyboard 
shortcuts (accelerators) specified for commands in Siebel Tools, these shortcuts will take precedence 
over the shortcuts from Siebel Tools for the agent’s session.

Chapter 4, Advanced Communications Configuration 1

December 10, 2001

Integrating with Siebel Scripting Languages 1

On page 4-46, it should be noted that Siebel eScript is supported only on the server side, not on the 
end user’s browser.

Chapter 5, Configuring Communications User 
Interface Elements 1

December 10, 2001

Configuring Communications Menu Commands 1

Command Parameters Affecting Communications Menu Items
On page 5-15, the following note should be included after the description of the HotKey parameter:

NOTE: If you specify keyboard shortcuts, using the HotKey parameter, that conflict with keyboard 
shortcuts specified in Siebel Tools, these shortcuts will take precedence over the shortcuts from 
Siebel Tools for the agent’s session.
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Configuring Recipient Groups for Outbound Requests and Templates 1

Predefined Recipient Groups
Table 5-3, which starts on page 5-26, lists the predefined recipient groups for outbound 
communication requests and advanced communications templates. This list may not correspond 
exactly to the recipient groups available for your Siebel applications: some recipient groups have 
been removed and new ones have been added.

Configuring Additional Recipient Groups
On page 5-30, it is stated that the name of the Recipient Sources applet changes when a recipient 
group has been chosen, to reflect the recipient source business object—such as Opportunities, when 
Opportunity Contacts is the recipient group. In fact, the name of the applet does not change, but the 
recipient source business object is identified using a label displayed on the right side of the applet 
header area.

Configuring Recipients for Send Email and Send Fax 1

In this section, beginning on page 5-33, references to the “Choose Recipient dialog box” should be 
changed to the “Pick Recipient dialog box.”

Configuring Default Templates for Send Email Command 1

On page 5-38, the following note should be included at the end of this section:

NOTE: Setting a default template for the Send Mail command, as described above, overrides template 
visibility by channel. For example, if a template is specified as the default email template for Change 
Request applets, this same template will also be the default template for these applets for the fax 
channels (using the Send Fax command).
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Chapter 6, Administering Siebel Communications 
Server 1

December 10, 2001

Administering Communications Session Manager 1

Overview of Communications Session Manager
On page 6-21, the following note should be inserted below the top paragraph:

NOTE: If the Communications Session Manager stops running or becomes unavailable for some 
reason, all connected users (agents) will receive the following message in an alert-type dialog box 
in their browser: “Connection to Communications Server is down. Toolbar is reset!” For each such 
agent, the communications toolbar displays as if no communications driver is loaded. That is, the 
toolbar is displayed but most of the toolbar buttons are unavailable.

Chapter 7, Communications Operations for End Users 1

December 10, 2001

Using Communications Menu Commands 1

On page 7-21, after the paragraph mentioning example commands that may be available in the 
Communications submenu, the following text should be added:

Agents can choose the following menu commands in order to redisplay messages, such as error 
messages, that had appeared in the area to the right of the application-level menus. 

■ View > Communications > Toolbar > Previous Message

■ View > Communications > Toolbar > Next Message

The Previous Message command displays the previous message in the stack of messages that had 
appeared since the time the agent logged on. The Next Message command displays the next such 
message, when the agent has previously invoked the Previous Message command. These commands 
may be helpful for troubleshooting purposes.
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Sending Email, Fax, and Page Messages 1

Using the Send Email Command
For the section “Using the Send Email Command,” which begins on page 7-27, the following text 
should replace the existing text. Note that the “Choose Recipient dialog box” is now referred to as 
the “Pick Recipient dialog box.”

Using the Send Email Command
You can send email, optionally including Siebel application content, to any recipient whose email 
address is stored in the Siebel database.

Whether the Pick Recipient dialog box appears after Step 2 depends on what kind of data currently 
has the focus when you choose the Send Email command:

■ If the list or form that has the focus represents people, such as a list of contacts or employees, 
then the Pick Recipient dialog box does not appear. The Send Email dialog box appears.

■ If the list or form that has the focus does not represent people, such as a list of service requests 
or accounts, then the Pick Recipient dialog box appears. You can choose recipients, such as the 
contacts associated with service requests.

To use the Send Email command

1 Optionally, select one or more records of contacts, employees, or other persons for whom email 
addresses are defined in the Siebel database.

2 Do one of the following:

■ From the application-level menu, choose File > Send > Email.

■ Press F9.

■ Click to the right of Initiate Work Item on the communications toolbar, then click Send Email. 

■ Click Initiate Work Item when the displayed ToolTip text is “Send Email.”

For more information, see “Initiating Work Items” on page 7-16.

The Pick Recipient dialog box appears, if you did not specify recipients in Step 1. If you already 
chose recipients, go to Step 4.
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3 In the Pick Recipient dialog box, specify the recipient or specify no recipient.

The available recipients to choose from depend on the application context. For example, in the 
Service Request screen, the choices are Service Request Contact and Service Request Owner.

The Send Email window appears.

4 For the From field, specify the profile to represent who is sending the message.

The profiles listed are those created for communications drivers that support email, such as 
Internet SMTP/POP3 Server. In some cases, a profile may be inserted automatically. You can 
specify a default profile in the User Preferences screen, Outbound Communications tab.

5 For the To, CC, or BCC fields, do one or more of the following:

■ Verify any recipients that were inserted automatically in previous steps.

■ Type any additional recipient email addresses.

■ Click the To, CC, or BCC button and explicitly specify individual persons from the address 
book dialog box. For each intended recipient, check the To, CC, or BCC field, then click OK.

6 Optionally, for the Body drop-down list, choose the name of a communications template (of type 
Body) to insert into the message body.

You can insert more than one template. In some cases, a template may be inserted automatically. 
Substitution applies to the template text upon insertion, if the fields exist in the current list or 
form (containing the focus) in the Siebel application.

7 Optionally, verify or enter text for the subject line.

Text may have been inserted into the subject line automatically when you chose a template.

8 Optionally, enter free-form text, such as to modify or add to the template text.

9 Optionally, specify attachments or literature.

10 Optionally, check spelling for your message.

11 Click Send, or click Cancel if you decide not to send the email message.

Using the Send Fax Command
For the section “Using the Send Fax Command,” which begins on page 7-29, the following text 
should replace the existing text. Note that the “Choose Recipient dialog box” is now referred to as 
the “Pick Recipient dialog box.”
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Using the Send Fax Command
You can send a fax, optionally including Siebel application content, to any recipient whose fax 
number is stored in the Siebel database.

Whether the Pick Recipient dialog box appears after Step 2 depends on what kind of data currently 
has the focus when you choose the Send Fax command:

■ If the list or form that has the focus represents people, such as a list of contacts or employees, 
then the Pick Recipient dialog box does not appear. The Send Fax dialog box appears.

■ If the list or form that has the focus does not represent people, such as a list of service requests 
or accounts, then the Pick Recipient dialog box appears. You can choose recipients, such as the 
contacts associated with service requests.

To use the Send Fax command

1 Optionally, select one or more records of contacts, employees, or other persons for whom fax 
numbers are defined in the Siebel database.

2 Do one of the following:

■ From the application-level menu, choose File > Send > Fax.

■ Press Ctrl+F9.

■ Click to the right of Initiate Work Item on the communications toolbar, and then click Send 
Fax.

■ Click Initiate Work Item when the displayed ToolTip text is “Send Fax.”

For more information, see “Initiating Work Items” on page 7-16.

The Pick Recipient dialog box appears, if you did not specify recipients in Step 1. If you already 
chose recipients, go to Step 4.

3 In the Pick Recipient dialog box, specify the recipient or specify no recipient.

The available recipients to choose from depend on the application context. For example, in the 
Service Request screen, the choices are Service Request Contact and Service Request Owner.

The Send Fax window appears.

4 For the From field, specify the profile to represent who is sending the message.

The profiles listed are those created for communications drivers that support email or fax, such 
as Internet SMTP/POP3 Server. In some cases, a profile may be inserted automatically. You can 
specify a default profile in the User Preferences screen, Outbound Communications tab.
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5 For the To, CC, or BCC fields, do one or more of the following:

■ Verify any recipients that were inserted automatically in previous steps.

■ Type any additional recipient fax addresses, using the appropriate format for your fax 
integration.

■ Click the To, CC, or BCC button and explicitly specify individual persons from the address 
book dialog box. For each intended recipient, check the To, CC, or BCC field, then click OK.

6 Optionally, for the Body drop-down list, choose the name of a communications template (of type 
Body) to insert into the message body.

You can insert more than one template. In some cases, a template may be inserted automatically. 
Substitution applies to the template text upon insertion, if the fields exist in the current list or 
form (containing the focus) in the Siebel application.

7 Optionally, verify or enter text for the subject line.

Text may have been inserted into the subject line automatically when you chose a template.

8 Optionally, enter free-form text, such as to modify or add to the template text.

9 Optionally, specify attachments or literature.

10 Optionally, check spelling for your message.

11 Click Send, or click Cancel if you decide not to send the fax.

Chapter 8, Working with Communications Templates 
and Outbound Communications Requests 1

December 10, 2001

Defining Templates for Outbound Communications 1

Understanding Communications Templates
On page 8-4, in the section about HTML wrapper templates, the reference to the “eMail Response - 
Process Message” workflow should be removed. For additional information on this topic, refer to 
Siebel eMail Response Administration Guide, MidMarket Edition.
11



Creating Basic Templates
On page 8-8, in the procedure for creating a basic template, Step 3e, saving the template record, is 
not necessary in order to populate the Available Substitutions list.

Creating Advanced Templates
On page 8-11, in the procedure for creating an advanced template, Step 3f, saving the template 
record, is not necessary in order to populate the Available Substitutions list.

Fields for Templates and Template Items
On page 8-19, the following note should be inserted after the description for the Public field:

NOTE: The Public field is ignored for any template that is specified to be sent using an outbound 
communication request initiated through Siebel Workflow. Any defined template can be specified.

Fields for Templates and Template Items
On page 8-21, the description for the Attachment Label template item field is incorrect or misleading.

For an HTML template, for any template item that is not specified for the message body, if you do 
not specify a string using the Attachment Label field, the template item will be a true attachment—
it will not be embedded in the HTML. If, however, you specify a string using this field, the template 
item will be an embedded attachment. In the latter case, the Attachment Label string must match a 
reference in the HTML in order for message recipients to able to access the template item content.

The following text should replace the existing text:

Attachment Label. Specify a label for a template item that is to be an attachment to an email message. 
In this context, an “attachment” is any template item for which Message Body is not checked.

■ For a template item that you are adding as an attachment to a plain-text email message, the 
Attachment Label field provides an optional string to name the attachment. If an attachment label 
is not specified, the file name and extension are used as the attachment label.

■ For a template item that you are adding as an attachment to an HTML message (such as can be 
sent using an outbound communication request):

■ The Attachment Label field specifies a string that is used for embedding the template item 
into the HTML. The string must exactly match a reference in the HTML markup, in order for 
the HTML content to provide recipients access to the template item content, such as an 
embedded picture. For example, for an attachment label “my_picture.jpg” (without the 
enclosing quotes), the matching HTML reference for this embedded picture file would be:
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<IMG SRC="my_picture.gif">

The email client for the recipient matches these strings in order to correctly locate and display 
each picture, or other embedded attachment.

■ If an attachment label is not specified, the attachment is a true attachment to the HTML email 
message, and is not embedded in the HTML message.

NOTE: If an attachment label is specified that does not exactly match a reference in the HTML 
markup, then the recipients may not be able to access the template item. The template item 
would be an embedded attachment for which the HTML markup provides no access.

For more information, see the description for the Attachment Name field, later in this section.

NOTE: Embedding pictures or other referenced files in HTML email makes the email larger and makes 
it take longer to send. You can also make a file available on the Internet and only include its URL in 
the HTML message. If you do this, there is no need to add the files as template items. However, 
recipients can view the images only if they are connected to the Internet when they read the email.

Working with Outbound Communication Requests 1

Fields for Outbound Communication Requests
On page 8-33, it is stated that the name of the Recipient Sources applet changes when a recipient 
group has been chosen, to reflect the recipient source business object—such as Opportunities, when 
Opportunity Contacts is the recipient group. In fact, the name of the applet does not change, but the 
recipient source business object is identified using a label displayed on the right side of the applet 
header area.
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Appendix A, Interactive Driver for CTI 1

December 10, 2001

Using Siebel CTI Complete (Dialogic CT Connect) 1

Dialog CTI Driver Parameters
In Table A-1, which begins on page A-11, the names of some parameters for the Dialogic CTI driver 
are not as documented. The name corrections are as follows:

■ Driver:LogDebug – should be LogDebug (applies to both driver and service)

■ Service:NetCallPort – should be Driver:NetCallPort (applies to driver, not service)

Dialog CTI Driver Parameters
In Table A-1, on page A-17, the Dialogic CTI driver parameter Service:WaitForRouteData is invalid 
and should be removed. It should also be removed from Table F-2 in Appendix F.

Appendix B, Drivers for Email, Fax, and Other 
Systems 1

December 10, 2001

Interfacing to Email and Fax Servers 1

Integrating with Fax Systems
On page B-5, the following note should replace the existing note below the second paragraph of the 
section “Integrating with Fax Systems”:

NOTE: After a fax is sent to the email server for submission to the fax server, the Communications 
Outbound Manager server component may log that the fax has been successfully sent. However, this 
log file message does not indicate whether the fax was sent to a valid fax number. Most fax software 
sends a notification message when a fax cannot be transmitted to the destination. Some fax software 
applications can also be set up to send a notification when a fax is transmitted successfully. If the 
fax server has been configured to send notifications to the sender, the notification would appear in 
the mailbox that corresponds to the profile that was used to send the fax.
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Driver Parameters for Internet SMTP/POP3 Server
In Table B-1, beginning on page B-7, the names of several parameters for the Internet SMTP/POP3 
Server driver are not as documented. The name corrections are as follows:

■ Failed Email Folder – should be Failed Email Directory

■ Incoming Email Folder – should be Incoming Email Directory

■ Loopback Email Folder – should be Loopback Email Directory

■ Processed Email Folder – should be Processed Email Directory

■ Sent Email Folder – should be Sent Email Directory

Appendix F, Upgrading from Version 6.x 1

December 10, 2001

Upgrading Siebel CTI from Version 6.x (and Earlier) 1

Upgrade Issues for CTI/Communications Configurations
This Documentation Update mentions several communications configuration elements, such as 
parameters, that have changed (relative to Siebel Communications Server Administration Guide, 
MidMarket Edition), and notes that Appendix F should reflect these changes. For details, please refer 
to earlier sections of this Documentation Update.
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